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1. Overview
Data Object Open Replication (LeeTech DOOR ) is an innovative member
of the LeeTech product family.  As its name implies, DOOR provides a
door that allows data stored on an HP e3000 system to be replicated to
SQL-based relational database management systems (RDBMS) of Oracle,
Sybase, Informix and Microsoft.

The majority of HP e3000 systems store data in non-relational IMAGE
databases.  The non-relational nature of these legacy databases makes them
unusable with today’s popular SQL-based RDBMS.  This incompatibility
makes it difficult   if not impossible   for companies to provide their
legacy data to users of such mainstream applications as Oracle, SQL Server,
Informix, DB2, Sybase and other SQL-based applications.  Consequently, a
mechanism is needed to help make legacy data available to SQL-based
RDBMS.  DOOR provides that facility to convert data to new database
systems.

DOOR streamlines and tightly couples HP e3000’s legacy data to RDBMS
by providing a real-time conversion facility between the two environments.
Using a Windows-based interface, a system administrator can simply point
and click to select data-flow mapping, source and destination servers and
other parameters governing the transmission of information between the
two environments.

Figure 1-1. Overview of LeeTech DOOR
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DOOR uses the powerful OLTP portion of LeeTech Software’s AIM
middleware to create multiple pipelines that deliver real-time data
replication.  Moreover, DOOR does not limit the number of destination
servers that will receive the converted legacy data, nor does it restrict the
number of source servers from which the legacy data is replicated.  This
means, replication is performed in real time, making the replicated data
available immediately for Web and other users who require instant access to
mission-critical data.

DOOR uses a message-queuing approach to replicate data.  This approach
is important because, should the destination server go down, the originating
server still retains data integrity until the requester is available.

Real World Examples
A Stock Brokerage Firm

A stock brokerage house has been running its IT systems on HP e3000s
with non-relational IMAGE databases since the mid ‘80s.  With the ever-
changing face of technology, the brokerage house wants to make certain
data available to its customers through the Web and to brokers at remote
sites over its Intranet.  Concurrently, the IT staff has acquired a UNIX based
HP e9000 system containing a relational Oracle database.  The company
realizes that it may have to move the data on the HP e3000 system to the
relational database on the new HP e9000 system in order to make the data
accessible on the Web.  At the same time, the company has no desire to
eliminate the HP e3000 system or the well-tuned applications running on
them.  In effect, they want to have two databases one relational and the
other non-relational, both with identical data at all instances.

Ultimately, the company’s goal is to make data from both systems available
in real-time to the end-user.

DOOR provides the perfect solution, allowing the brokerage house to
continue using their existing HP e3000 and its installed base of application
software, while making the data in the IMAGE databases available to
relational database and Web users.

A Managed Healthcare Organization
An HMO has been running their legacy healthcare administration system on
HP e3000s with the venerable non-relational IMAGE database.  Yet now
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they would like to begin feeding data to new, ancillary applications utilizing
relational databases as well as make subsets of the IMAGE data available in
real time to new, Web-based, applications like a Web-based eligibility
verification process.  At the same time, the company is not ready to replace
the legacy system which they currently run on.  Fortunately the company
has a UNIX based HP e9000 with Oracle available, though a NT server
with SQL Server or Oracle or even another HP e3000 with Oracle or
ALLBASE/SQL would also be usable.

With the LeeTech DOOR® product, the company can replicate their
IMAGE healthcare data to one or more of these relational database
environments in real-time making the data available to the new applications
all without impacting their legacy system.
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2. Quick Start
This chapter walks through a simple list of tasks to quickly start the data
replication process with LeeTech DOOR.

•  Installing the software

Install the software on PC and on all kind of database servers involved in
data replication.  Please refer to section 3.

•  Starting the listener

The “LISTNER” is a daemon to serve any data transaction requests through
the network.  It acts as a gateway that allows communication between HP
e3000 systems and other servers.  Therefore it is important to be sure that a
listener is started for both source and destination servers.  Please refer to
section 3-4.

•  Configuring the data mapping

With its friendly user interface, the LeeTech DOOR Administration tool can
help configure the data mapping with a simple click, drag and drop.  The
final mapping configuration file is stored in the DOOR account of the HP
MPE/iX machine where the source TurboIMAGE database resides.  Please
refer to sections 4 and 5.

•  Running DOOR

After the data mapping configuration file has been successfully saved in the
source machine, the command DOOR.PUB.DOOR launches the program.
The program will automatically intercept the data changes in TurboIMAGE
and replicate to the desired remote sites.

Example
 In this example, a TurboIMAGE database, ORDERS.DB1.DOORSRC,
resides in a HP e3000 machine.  The goal is to replicate the data to multiple
remote databases on different platforms such as ALLBASE/SQL on HP
e3000 and Oracle on HP-UNIX.

Starting the Listener
HP e3000
Log into the LeeTech DOOR account on HP e3000.
:HELLO USER,MGR.DOOR
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Stream the job of listener.
:STREAM JDOOR.PUB.DOOR

Verify whether the listener is running successfully.
:LANUTIL.PUB.DOOR
LT928A: MGR.DOORSRC(7): LANUTIL.PUB.DOOR

LANUTIL (A.05.02.00) LeeTech Software Inc.
Copyright 1993-, All Rights Reserved.

HOST:[127.0.0.1] APPLICATION:[door]

Commands: LIST - shows all connected users.
KILL id - kills the specified user.
STOPALL - terminates listener and all

users.
HOST id - sets to new host node name.
APPL id - sets to new application name.
SETQ qname #servers

- sets # of standby servers for
a queue

EXIT - ends the LANUTIL.
LANUTIL>> LIST

NO USER CONNECTION.

HP-UNIX
Log into the system as “root” user with the appropriate Oracle environment
setup.

Start the listener.
:/opt/door/lbin/listner 32700
or
:/opt/door/lbin/listner DOOR
(where DOOR is the TCP/IP service name).

Verify whether the listener is running successfully.
:/opt/door/bin/lanutil 32700

HOST:[127.0.0.1] APPLICATION:[door]
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Commands: LIST - shows all connected users.
KILL id - kills the specified user.
STOPALL - terminates listener and all

users.
HOST id - sets to new host node name.
APPL id - sets to new application name.
SETQ qname #servers

- sets # of standby servers for
a queue

EXIT - ends the LANUTIL.
LANUTIL>> LIST

NO USER CONNECTION.

Configuring the Data Mapping for Windows
Start the PC mapping administration tool.  The main screen displays:

Figure 2-1. The Mapping Tool Main Screen

Connect to the source TurboIMAGE database from the screen menu.  Select
the Open Source DB command from the Database menu.  Enter the
required information.
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Figure 2-2. The Open Source Database Dialog Box

Connect to the target RDBMS.  From the Database screen menu, select the
Open Destination DB command.  Connect to:

ALLBASE/SQL on HP e3000

Figure 2-3. Dialog Box for ALLBASE/SQL as the Target Database
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Oracle on HP-UNIX

Figure 2-4. Dialog Box for Oracle as the Target Database

After successful database connection, the mapping sequences to follow are
Select a source data set, Select a target data table and Assign the source data
item to target data column.
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Choose the source data set CUSTOMER, a target table
MGR@DOORSRC.CUSTOMER from ALLBASE and another target table
DOOR.CUSTOMER from Oracle.
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Figure 2-5. Selecting a Source Data Set and Target Tables

or each mapped Source Data Set, there is a Database Configuration
apping window associated to it.  Double-click on the Source Data Set grid
 bring up the mapping assignment window displaying the Source Set and
arget Database fields.  Double click on the target data table grid to bring
p the mapping relationship displaying the target database table.  Assign a
ombination key to the target database table for later data replication use.
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The key will affect whether LeeTech DOOR updates or deletes the correct
record in the target table.

Note: LeeTech DOOR will have no knowledge about the key information.

After completing the mapping relationship, save the configuration file(s) to
the HP e3000 machine where the source database resides.  To do so, click
on the File menu and select the Save command.

Starting the DOOR Replication Engine
After the configuration file has been successfully saved in the source HP
e3000 machine, running the DOOR replication engine is possible.  The
command script DOOR.PUB.DOOR controls the engine.  Before using the
example DOOR.PUB.DOOR script, modification of the user-defined
section variables FIFO, LOGFILE, DATABASE, MODE and
BYPASS_FLAG is required to suit the needs of the TurboIMAGE database
operation environment.  Please refer to section 6.
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3. Installation
LeeTech DOOR is supplied in three parts, a client, a source server and a
destination server component.  The client Windows-based mapping
administration tool is available on CD-ROM, suitable for installation on a
standard PC.  HP e3000 and HP-UX for Oracle server components come on
a DAT tape.  All other Windows server software is on CD-ROM.

The communication between the GUI (Graphical User Interface)
Administration tool and DOOR replication engine is based on a TCP/IP
protocol and uses a Windows socket (winsock.dll).

After completing the installation, the listener process needs to be brought up
on every machine participating in the data replication flow, including the
source HP e3000 machine and any destination platforms with the target
RDBMS.

Installing the Mapping Administration Tool
System Requirements:

IBM or compatible PC
80486 or above
Hard drive with at least 3 megabytes free
VGA or SVGA monitor
Mouse
Windows 95/98/NT

Note: Installation on Windows NT server is possible but not recommended.

The following procedures assume installation is started from the CD-ROM
drive of a computer.

1. If not already running, load Windows.

2. Insert the DOOR media into the appropriate  drive for installation.

3. Autorun will automatically begin installation or click on
SETUPEX.EXE command and follow the directions on the screen.

4. Select Compact Setup for the installation of just the DOOR
Administration Mapping Tool.

5. Custom Setup allows manual choosing of the components to be
installed.
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Installing the Server
Installing on MPE/iX

1.  Log on as system manager:
:MANAGER.SYS

2.  Restore the tape as follows:
:File T;Dev=Dat or Device Number
:Restore *T;@.@.DOOR;CREATE

3.  After the tape has been restored, execute the command file
:DOORINST.PUB.DOOR

This sets the proper security for the account and groups.  This
command will also prompt for permission to stream some standard
Listener jobs used to demonstrate the product.

Starting the MPE/iX Server
The listener is a server daemon that should be launched before any mapping
configuration and data replication.  To start the listener, refer to section 3-6.

Installing on HP-UX
1. “Root” authority is necessary to restore the server files with correct

attributes.

2. Mount the DOOR tape and place the drive online.

3. Restore the DOOR files INSTALL and LEETECH.0 as follows:
$tar xvf /dev/rmt/0m (device name)

4. Run INSTALL.  It will create the following directories if they do not
already exist:

$/opt/door/bin
$/opt/door/lbin
$/etc/opt/door

5. Delete the files INSTALL and LEETECH.0 upon successful
completion of the DOOR installation:
:rm INSTALL LEETECH.0

Starting the HP-UX Server
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The listener is a server daemon that should be launched before any mapping
configuration and data replication.  To start the listener, refer to section 3-4.

Installing on Windows NT Server
System Requirements:

IBM or compatible PC
80486 or above
Hard drive with at least 3 megabytes free
VGA or SVGA monitor
Mouse
Windows 95/98/NT

Note: Installation on Windows NT Server 4.0 or above is highly
recommended.

1. Insert the media into the appropriate  drive for installation.

2. Autorun will automatically begin installation or click on
SETUPEX.EXE command and follow the directions on the screen.

3. Select Typical Setup for the installation of both the NT SQL Server 7.0
Engine and the NT Listener Utility.

4. Custom Setup allows manual choosing of the components to be
installed.

5. When setup is completed click on the NT Listener Utility icon and the
opening screen should appear.

6. To work with the NT Listener Utility, refer to section 3-5.

Configuring the LAN
Please consult a network system administrator for this section.

SERVICES file

1. Find the SERVICES file on the PC and insert the line:

DOOR 32700/tcp door

DOOR is the port name used by the program.  The “32700/tcp” portion of
the entry is the port ID, which must be identical to the server’s SERVICES
file.

2. The SERVICES file on the PC is located in:
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Win 95/98 \windows\
Win NT \winnt\system32\drivers\etc\

HOSTS file

3. The SOCKET driver must exist.  Make sure the winsock.dll file is
accessible.  It is either in the \windows directory or in a directory listed
by the path variable.

4. Find the HOSTS file on the PC and insert the host IP address and its
alias (node) name.  Use PING.EXE to verify the accuracy of the host IP
address.

5. The HOSTS file on the PC is located in:

Win 95/98 \windows\
Win NT \winnt\system32\drivers\etc\

Listener
MPE/iX Listener - LISTNER.PUB.LEETECH

To start a listener insert:
STREAM JDOOR.PUB.DOOR

The listener program (LISTNER) accesses 2 files, HOSTS and SERVICES,
which must be setup correctly before streaming the listener job (JDOOR).

The HOSTS.NET.SYS file name is used by default.  It is possible to create
a personal HOSTS file and use a file equation to redirect HOSTS.NET.SYS
to the new HOSTS file.  The HOSTS file contains those node names that
DOOR clients can access programmatically.  For LeeTech DOOR, a
“127.0.0.1 localhost loopback” line is required in the HOSTS file.

The SERVICES.NET.SYS file name is used by default.  It is possible to
create a personal SERVICES file and use a file equation to redirect
SERVICES.NET.SYS to the new SERVICES file.  The SERVICES file
contains service names and associated port IDs.  These must be a unique
value to the specific HP e3000 machine.  In addition, the SERVICES file is
used to establish the initial network connection between client and server.
Different HP e3000 machines can use the same service name and port ID.
On the network, the machine node name and port ID are treated as one
combined identifier.
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UNIX Listener - /opt/door/lbin/listner
Start the listener from the root user login.  To start a listener insert:

/opt/door/lbin/listner “port_ID”

The port ID could be a TCP/IP port number or a port alias name.

LISTNER: - /opt/door/lbin/listner
HOSTS: - /etc/hosts
SERVICES: - /etc/services

Windows NT Listener
LeeTech AIM Service Manager will allow the user to install the service
daemon for LeeTech DOOR.  To start the DOOR Listener/Service, log in as
a system administrator.

Figure 3-1. Opening Screen of LeeTech AIM Service Manager

Parameters
Service Name The name of the listener.  The user can create a new

service for DOOR, i.e. a listener for DOOR.
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Port The TCP/IP Port where the listener is waiting when the
client program wants to connect to the server program.

Status This informs whether the listener is active or inactive.

Comment This could be any comment about a specific listener
program.

Creating the DOOR Listener
Click on service and then click on new, or use the toolbar icon for new
service.  The screen below will appear.  Type in the parameter values:

Figure 3-2. NT Service Manager New Service Screen

Parameters
Service Name The Service Name is the name the LeeTech AIM

listener is labeled for each new service.  For LeeTech
DOOR, type in DOOR.

Port The TCP/IP port is where the listener waits when the
client program wants to connect to the server
program.  The default port number for DOOR is
32700.
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Comment This allows adding in any comments that will assist
in quick referencing a specific function or
explanation the listener brings up on the screen.

Log File Name This is the file name to store the system log and
debug trace.

Standby Queue List This is the list of queues the selected listener
monitors.  This serves no purpose for DOOR.

Modifying and Deleting Service
To modify a service, highlight the service name and click on the modify
icon (the folder) in the tool bar.  This will bring up the Modify Service
screen.  To modify a service, simply input the new information into the
proper fields.

Figure 3-3. NT Screen for Deleting/Modifying Service

To delete a service, highlight the service name and click on the delete icon
(the X) in the tool bar.  This will delete the service highlighted.
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Starting and Stopping Service
To start a service, highlight the service name to start and click on the start
service icon (the green light) in the tool bar.  The highlighted service name
will start.

Figure 3-4. NT Screen for Starting/Stopping Service

To stop a service, highlight the service name to stop and click on the stop
service icon (the red light) in the tool bar.  The highlighted service will
cease.

Listing Connections to Listener
To list connections, highlight the service name desired and click on the list
connections icon (the magnifying glass).  A list of server programs will
appear in a data box.
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Figure 3-5. NT Screen for Checking and Listing Connections to the
Listener
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4. Starting the Mapping Administration
Tool
This chapter describes how to start DOOR’s mapping administration tool.
This application allows data to be mapped between non-relational and
relational databases.  This chapter also describes the components of the
application’s main screen.

Starting the Mapping Administration Tool
After installing the mapping administration tool, it can be started by using
the Start button in the Windows taskbar or by double clicking on an icon in
the DOOR program group.

Taskbar Method
To start the Administration tool from the Taskbar:

1. Click on the Start button in the Taskbar.

2. Choose Programs, LeeTech Door and LeeTech Door.

The main screen in Figure 4-1 appears.

Icon Method
To start the administration application from an icon in the DOOR program
group:

1. Double-click on the DOOR application icon.

The main screen in Figure 4-1 appears.
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Figure 4-1. DOOR Main Screen

Understanding the Main Screen
All administration application activities are started from the main screen.
The main screen contains the following components (refer to Figure 4-2):

•  A title bar appears at the top of the main screen.  Initially, the title bar
displays LeeTech DOOR.  Upon opening source and destination
databases, the database names appear in the title bar.

•  A menu bar appears below the title bar.  The menu bar contains drop-
down menus.  When on one of these menus is clicked, a list of
commands appears.

•  A toolbar appears below the menu bar.  The toolbar contains buttons
for executing frequently performed activities.  When the pointer is
moved to a button, an explanation of the button appears at the pointer
location.  Each toolbar button has a corresponding command in a drop-
down menu.  The View menu has a Toolbar command that displays or
hides the toolbar.  The toolbar is displayed as part of the default setting.
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•  The display area appears below the toolbar.  When database
information is mapped between the source and the destination
databases, the screen displays the databases in this area.

•  A status bar at the bottom of the main screen provides status
information.  The View menu has a Status Bar command that displays
or hides the status bar.  The status bar is displayed as part of the default
setting.

Sum

Menu Bar

Display Area

Toolbar

Title Bar
Status Bar
 Software Inc. Summary of Menus and Command 4-3

Figure 4-2. DOOR Main Screen Components

mary of Menus and Commands
Table 4-1 summarizes the menus and commands in the DOOR main screen.
For more information about a command, refer to the section denoted by the
See Page column.
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Table 4-1. Summary of DOOR Menus and Commands

Menu Command Description See
Page

File Open Opens a configuration. 
Save Saves a configuration. 
Exit Exits from the DOOR application. 

Database Open Source
DB

Opens a source database that
contains the data to be mapped.

5-1

Open
Destination
DB

Opens a destination database
where the data will be mapped to
from the source.

5-4

Table Select Source
Set

Allows selection of a source data
set.

5-6

Select
Destination
Table

Allows selection of a destination
table.

5-8

View Toolbar Displays or hides the toolbar. 4-5
Status Bar Displays or hides the status bar. 4-3

Window Cascade Cascades multiple screens on the
monitor to simplify viewing.

__

Tile
Horizontal

Tiles multiple screens
horizontally on the monitor.

__

Tile Vertical Tiles multiple screens vertically
on the monitor.

__

Arrange
Icons

Arranges icons on the Windows
desktop.

__

Help Provides on-line help for
performing DOOR-related tasks.

__

Summary of Toolbar Buttons
Table 4-2 summarizes the toolbar buttons in the DOOR main screen.  For
more information about a toolbar button, refer to the section denoted by the
See Page column.
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Table 4-2. Summary of DOOR Toolbar Buttons

Toolbar
Button

Description See
Page

Opens a configuration. __

Saves a configuration. __

Prints the displayed configuration information. __

Opens a source database that contains the data to be
mapped.

5-1

Opens a destination database where the data will be
mapped to from the source.

5-4

Selects a data set in the source database. 5-6

Selects a table in the destination database. 5-8
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5. Mapping Data Between Databases
This chapter describes how to use the administration application to map
data from a source database that contains non-relational data to a destination
database that contains relational data.  The procedure involves the following
steps:

1. Opening a source database.  The source database contains the data that
will be mapped to the destination database.  See section 5-1.

2. Opening one or more destination databases.  The destination database
will contain the data mapped from the source database.  See section 5-
4.

3. Selecting one or more source data sets in the source database.  The
source data set contains the data that will be mapped to one or more
destination tables.  See section 5-6.

4. Selecting one or more destination tables from the destination
database(s).  The destination table(s) will contain data mapped from the
source data sets.  See section 5-8.

5. Mapping the data from the source data set(s) to the destination table(s).
See section 5-9.

Opening a Source Database
The first step when mapping data from a non-relational database to a
RDBMS is to open a source database.  The source database contains the
non-relational data that will be mapped to the destination database.

To open a source database:

1. Either choose Open Source DB from the Database menu.

OR

Click on the Open Source Database button in the toolbar .

Either step displays an Open Source Database dialog box similar to the
one in Figure 5-1.
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Figure 5-1. Open Source Database Dialog Box

2. Complete the following fields in the Open Source Database dialog box.

•  Database Info parameters:

Table 5-1. Open Source Database Info Parameters

Host Enter the name or IP address of the host where the
source database resides.

Port Enter the TCP/IP port number or name of the host where
the source database resides.

Platform From this drop-down list, select the source database
platform.

DBMS From this drop-down list, select the DBMS type
(vendor) associated with the source database.

Database
Name

Enter the full path where the source database resides.

Access Mode From this drop-down list, select an access mode for the
source database.  The access mode defines the type of
database activities available.  The drop-down list
provides 8 access modes.

•  Access modes 5, 6, 7 and 8 are read-access modes
and allow finding and reading of data entries.
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Table 5-1. Open Source Database Info Parameters (continued)

Access Mode •  Access mode 2 is an update-access mode that
allows read access and replacing of values in all
data entries except master data set key items and
detail data set search and sort items.

•  Access modes 1, 3 and 4 are modify-access modes
that allow updates and allow addition and deletion
of entries.

For a summary of these modes, see Table 5-3 in section
5-3.

•  User Logon parameters:

Table 5-2. Open Source Database User Logon Parameters

User Enter user name.
Password If a password is associated with the user name, enter the

password here.
Account Enter account information here.
Password If a password is associated with the account, enter the

password here.
Group Enter group name here.
Password If a password associated is with the group, enter the

password here.

2. Click on OK.  The name of the source database appears in the title bar
to indicate that the database is open.

3. Proceed to Opening Destination Databases in section 5-4.

Table 5-3. Summary of Database Access Modes

Access
Mode

Type of Access
Mode Granted

Concurrent Access
Modes Allowed

Notes

1 Modify 1, 5 Modify (with
locking)

Locking must be
used for updating
or modifying.

2 Update 2, 6 Update 
3 Modify None Exclusive access.
4 Modify 4, 6 Read 
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Table 5-3. Summary of Database Access Modes (continued)

Access
Mode

Type of Access
Mode Granted

Concurrent Access
Modes Allowed

Notes

5 Read 1, 5 Modify (with
locking)

Locking can be
used to coordinate
access with users
who are
modifying the
database.

6 Read 2, 4,
6, 8

Modify __

7 Read None Exclusive access.
8 Read 6, 8 Read

Opening Destination Databases
After opening a source database, one or more destination databases can be
opened.  The destination database will contain the data mapped from the
source database opened in the previous section.  For convenience, DOOR
allows the opening of one or more destination databases.

To open one or more destination databases:

1. Either choose Open Destination DB from the Database menu.

OR

Click on the Open Destination Database button in the toolbar .

Either step displays an Open Destination Database dialog box similar to
the one in Figure 5-2.
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Figure 5-2. Open Destination Database Dialog Box

2. Complete the following fields in the Open Source Database dialog box.

•  Database Info parameters (these parameters refer to database-specific
information):

Table 5-4. Open Destination Database Info Parameters

Host Enter the name of the host where the destination
database resides.

Port Enter the physical port of the host that is used to
access the destination database.

Platform From this drop-down list, select the destination
database platform.

DBMS From this drop-down list, select the DBMS type
(vendor) associated with the destination database.

Database Name Enter the full path where the destination database
resides.

Access Mode From this drop-down list, select an access mode for
the destination database (access mode differs by
vendor).

Database User Enter the name of the database user who has access
to the destination database.

Password Enter the password here if one exists.

•  User Logon parameters (these parameters refer to operating systems-
related logon information):
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Table 5-5. Open Destination Database User Logon Parameters

User Enter user name.
Password If a password is associated with the user name, enter

the password here.
Account Enter account information here.
Password If a password is associated with the account, enter

the password here.
Group Enter group name here.
Password If a password associated is with the group, enter the

password here.

2. Click on OK.

3. To open additional destination databases, repeat steps 1 through 3  (If
more than one destination database is opened, data can be mapped from
the single source database opened in the previous section to each
destination database opened).

4. When finished with opening the desired destination database(s),
proceed to Selecting Source Data Sets in section 5-6.

Selecting Source Data Sets
After opening a source database and one or more destination databases,
select one or more source data sets.  The data set is a collection of data
items in the source database.  For example, a CUSTOMER data set can
contain entries composed of ACCOUNT, LAST NAME, FIRST NAME,
STREET ADDRESS, CITY, STATE, ZIP and CREDIT RATING.

To select a source data set:

1. Either choose Select Source Set from the Table menu.

OR

Click on the Select a Data Set button in the toolbar .

Either step displays a Source DB Set Selection dialog box for the
source database opened.  Figure 5-3 shows an example of a Source DB
Set Selection dialog box.  The Host and DataBase fields show the host
and database locations of the source database.
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Figure 5-3. Source DB Set Selection Dialog Box

2. Double-click on the set list item that contains the data to be mapped, or
select an item and click on Select.  The Database Configuration
Mapping dialog box appears.  The source data set selected appears
below Source Data Set.  Figure 5-4 shows how the Database
Configuration Mapping dialog box looks when CUSTOMER is
selected from the Set List column in the Source DB Set Selection
dialog box.

Figure 5-4. Database Configuration Mapping Screen

3. To select additional source data sets, repeat steps 1 and 2.  Each
additional source data set selected appears in its own Database
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Configuration Mapping dialog box.  If more than one source data set is
opened, data can be mapped from each source data set.

4. Proceed to Selecting Destination Tables in section 8.

Selecting Destination Tables
After selecting a data set in the source database, select one or more
destination tables.  The destination tables will contain the data mapped from
the source data set(s) selected in the previous section.  When data in the
source database is mapped, the data will be placed in the table selected in
this procedure.

To select one or more destination tables:

1. Either choose Select Destination Table from the Table menu.

OR

Click on the Select a Table button in the toolbar .

Either step displays a Destination Database Table Selection dialog box
similar to the one in Figure 5-5.

Figure 5-5. Destination Database Table Selection Dialog Box
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2. If there is access to more than one host, use the Host drop-down list to
choose the host that contains the destination data desired.  If more than
one destination database has been opened, use the Database drop-down
list to select the database whose data is to be mapped from the source
data set.

3. In the list, double-click on the table whose data will be mapped from
the source data set, or select a table and click on Select.  The selected
table appears in the Destination Table field in the Database
Configuration Mapping dialog box.

4. Repeat steps 1 through 3 to select additional tables.  Figure 5-6 shows a
Database Configuration Mapping dialog box that has a single source
data set called CUSTOMER and two destination tables (ACCOUNT
and CUSTOMER) that both reside on a host called HPUX800.

Figure 5-6. Selecting a Table

5. With the source data set(s) and destination table(s) displayed in the
Database Configuration Mapping dialog box, mapping data from the
source data set(s) to the destination table(s) can begin.  Proceed to
Mapping Data in section 5-9.

Mapping Data
The following steps describe how to map data from the source data set(s) to
the destination table(s) in the Database Configuration mapping dialog box.

To map data:
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1. In the Database Configuration mapping dialog box, double-click on the
source data item list.  In Figure 5-6, for example, it is possible to
double-click anywhere in the CUSTOMER source data set.  A
Database Configuration dialog box similar to the one in Figure 5-7
appears.  Map data by dragging and dropping entries from the source
data item list on the left to entries in the destination column list on the
right.  The table at the bottom of the dialog box displays information
about the entries in the currently selected source data set and shows
which entries have been mapped between the two lists.

Figure 5-7. Database Configuration Dialog Box

2. If the currently selected source data set is not the one desired, use the
drop-down list at the top-left of the dialog box to select one of the other
open source data sets.

Note:  If a source data set that is not open is desired, use the procedure
in section 5-6 to open the desired source data set with the Database
Configuration dialog box displayed.  Then use the drop-down list in
Figure 5-7 to select that source data set.

3. If the destination column list displays only the names of the destination
tables (as shown in Figure 5-7), click on the plus sign (+) next to the

Source
Data Item
List

Destination
Column List
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name of the table that is to be mapped to.  The column entries appear in
the list (see Figure 5-8).

Note:  If a destination table that has not been selected is desired, use the
procedure in section 5-8 to select the desired destination table with the
Database Configuration dialog box displayed (the table appears in the
Database Configuration dialog box automatically).

Figure 5-8. Displaying Column Entries

4. In the source data item list on the left, click on the first entry to map
and drag it over the appropriate entry in the destination column list on
the right (the pointer changes to a finger as dragging occurs), then
release the left mouse button.  The Confirm Assignment dialog box
appears (see Figure 5-9).
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Figure 5-9. Confirm Assignment Dialog Box

5. To map the selected source entry to the destination entry, click on OK,
(or click on Cancel to cancel this mapping).  If OK is clicked on, the
mapping is reflected in the table at the bottom of the Database
Configuration dialog box.  Refer to Figure 5-7.

6. Repeat steps 4 and 5 to map additional source and destination entries.

7. If a different decision is made about a mapping, click on the mapping
in the table at the bottom of the Database Configuration dialog box to
remove, then click on the Remove button.  The mapping is removed
from the destination, as indicated in the table at the bottom of the
Database Configuration dialog box.

8. When mapping is finished, click on Save to save the mappings.

9. Click on Exit to exit the Database Configuration dialog box.

Note:  If Exit is clicked on without clicking on Save, a message asks
whether to save the mappings or not.  Click on Yes to save them or on
No to discard them.  Click on Cancel to exit the dialog box without
saving the mappings.

10. To assign a key to an entry in the destination table, proceed to
Assigning a Key in section 5-13.  Otherwise, close the Database
Configuration Mapping dialog box.  If there is a prompt stating that the
set has changed, click on Yes to save the changes or on No to discard
them.
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Assigning a Key
The Database Configuration Mapping dialog box allows for assigning of a
key to a column in a destination table.  A key allows for fast, accurate and
efficient updates and deletions to data records on destination tables by
determining the location of a unique data entry.

Using the administration application one or more keys can be defined in the
destination table.  These keys can be the same as the ones used in the source
data or they can be different.

Note:  If there is failure to use a key, all the old values of the mapped data
will be used as key values when updating or deleting records in the
destination table.

To assign a key to a column in a destination table:

1. If the appropriate destination table appears in the Database
Configuration Mapping dialog, skip to step 2.  Otherwise, use the
procedure listed in Selecting Destination Tables in section 5-8 to
display the appropriate destination table in the Configuration Mapping
dialog box.  Refer to Figure 5-6.

2. In the columns below Destination Table on the right side of the
Database Configuration Mapping dialog box, double-click on the
leftmost column.  The Database Mapping Viewer appears (see Figure
5-10).

Figure 5-10. Database Mapping Viewer
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3. In the leftmost column, click on the table entry desired to be designated
as the key, then click on the Key button.  A key icon appears next to
the selected column (see Figure 5-11).

Figure 5-11. Designating a Key

4. To designate additional columns as keys, repeat step 3.

5. If a different decision is made about a key, click on the column and on
the Key button to remove the key designation from that column.

6. When finished with assigning keys, click on OK.  The Database
Mapping Viewer disappears and the key(s) designated appears in the
Database Configuration Management dialog box (see Figure 5-12).

7. Exit the Database Configuration Mapping dialog box.
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Figure 5-12. Database Configuration Management Dialog Box with Key
Example
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6. Starting the Replication Engine
After the data mapping has been configured and saved in the HP e3000
source machine, the administrator needs to start the DOOR data replication
engine.  This task could be merged with daily operation routines.

Before using the example DOOR.PUB.DOOR script, modify the user-
defined section variables FIFO, LOGFILE, DATABASE, MODE and
BYPASS_FLAG to suit the needs of the TurboIMAGE database.

DOOR utilizes the logging facility of TurboIMAGE to monitor and
replicate transactions occurring within a TurboIMAGE database.  It is
recommended that a new log file be created before the DOOR replication
engine is started.  This ensures that the data will be synchronized between
source and destination databases.  Please refer to the ‘TurboIMAGE
Database Management System Reference Manual’ for instructions on how
to manage logging with TurboIMAGE.  The manual is also available on the
Internet accessible at www.docs.hp.com.

To start the DOOR replication engine, run the modified command script
DOOR.PUB.DOOR.

Example 6-1. Starting the Replication Engine
:print door.pub.door

###########################################################

# The following command script demonstrates the procedures

# to use LeeTech DOOR to replicate a source database named

# TESTDB.DATA.DOOR with database logging enabled to log file

# DBLOG.DATA.DOOR.

###########################################################

#################################################

# Door Example Script

# User defined section

# This section to be defined by user!

#################################################

#

# Define FIFO name of log message pipe

# Define LOGFILE Image Database transaction log file
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# Define DATABASE Image data base name

# Define MODE Image database open mode, normally 1.

# Define BYPASE Door start mode.

# 0 - last record

# 1 - restart

#

setvar FIFO,"logfifo.pub.image"

setvar LOGFILE,"log01.pub.image"

setvar DATABASE,"data.pub.image"

setvar MODE,1

setvar BYPASS_FLAG,1

#################################################

# End of user defined section.

# Note from this point users should

# Only change LTDBG## debug flags

#################################################

# Set Door parameter names.

setvar L1,"jdoorint,mgr.door"

setvar L2,"jdoorsht,mgr.door"

setvar P1,"interc"

setvar P2,"shoot"

#################################################

# Build temporary job card files.

# Note if parms cause rec lengths > 80 use

# & to concatenate commands

#

build j1;rec=-256,16,f,ascii;disc=50000,32;temp

build j2;rec=-256,16,f,ascii;disc=50000,32;temp

# Create Job Card 1 Door Interceptor

echo !!JOB !L1 >>j1

echo !!setvar LTDBGOUT "DOORLOGI.LOG.DOOR" >> j1

# Debug Levels



Data Type

LeeTech Software Inc. SQL Statement Trace 6-3

#echo !!setvar LTDBG1 1 >> j1

#echo !!setvar LTDBG14 1 >> j1

#echo !!setvar LTDBG15 1 >> j1

# Remove previous FIFO file.

echo !!continue >>j1

echo !!purge !FIFO >>j1

# Run Interceptor

echo !!RUN !P1 & >>j1

echo !;info="!LOGFILE !DATABASE !MODE !FIFO !BYPASS_FLAG" >>j1

echo !!EOJ >>j1

#################################################

# Create Job Card 2 Door Shooter

echo !!JOB !L2 >>j2

echo !!setvar LTDBGOUT "DOORLOGS.LOG.DOOR" >> j2

echo !!setdump >> j2

# Debug Levels

#echo !!setvar LTDBG1 1 >> j2

#echo !!setvar LTDBG14 1 >> j2

#echo !!setvar LTDBG15 1 >> j2

# Wait for FIFO file to be created. Wait 60 seconds try 10
times.

echo !!waitfifo.pub.door !FIFO 60 10 >>j2

# Run shooter

echo !!RUN !P2;info="-d !DATABASE -l !FIFO" >>j2

echo !!EOJ >>j2

#################################################

# Cleanup Section

#

print j1

print j2

stream j1

stream j2
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purge j1,temp

purge j2,temp

SQL Statement Trace
LeeTech DOOR provides a SQL statement trace to help understand the
source and target database differences and configure the right mapping
relationship.  If the application was purchased from a third party vendor,
from the trace, the related source data sets for a specific application
procedure can be conversely constructed

The trace can also help identify data type conversion problems between two
different source items and target columns.

In example 6-1, deleting the comment (#) from the statement

# echo !!setvar LTDBG16 1 >> j2

will turn on the SQL trace and log into the file “DOORLOGS.LOG.DOOR.”

Error Logging
During the mapping configuration, the user can specify whether to stop or
continue the data replication if an error occurs.  The error logging is turned
on by setting the environment variable, LTDBG1, before the replication
engine and remote target agent listener are started.

For HP e3000:
setvar LTDBG1 1

For UNIX:
export LTDBG1=1

For Windows:
Set LTDBG1=1

Most errors occur when a unique record already exists in the target database
and a duplicate is created.  By looking at the error log, the mapping can
easily be reconfigured to add appropriate key information for target
database tables.
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7. Customer Support
LeeTech Software Inc. is dedicated to providing the highest quality software
products available.  In addition, LeeTech believes that high quality,
knowledgeable support is an essential element for full utilization of the
supplied products.  LeeTech has thus structured a complete support package
that is available with all supplied products.

All support contracts include telephone or message based support.
LeeTech’s staff is qualified to assist not only with product use, but also with
any database problems customers might have.  If problems prove extensive
and outside the scope of the maintenance contract, LeeTech can still assist
with low cost consulting.

In addition to specific service requests, LeeTech provides users with
periodic newsletters, software bulletins and other materials designed to help
ensure effective use of LeeTech products.  If you with to be placed on the
mailing list simply send your request to LeeTech.

LeeTech customer service can be contacted by any of the following.

Mail
Please send all inquiries or problems to:

LeeTech Software Inc.
2085 Hamilton Ave., Suite 200
San Jose, CA 95125
U.S.A.

Telephone Support
All LeeTech customers with a current support services contract can contact
LeeTech at the following numbers.

U.S.A. (800) 995-1987
All Other Countries (408) 253-1987
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Fax-Back Service
LeeTech maintains a 24-hour Fax number for customer input.  Questions
regarding support services receive immediate attention at the beginning of
the following business day.  Responses are returned by Fax or by the method
designated on the submittal.

Fax Number (408) 558-0802

Electronic Messaging
Questions or input can be made via electronic mail.

•  Support needs can be mailed to:

support@leetech.com

•  Information inquiries can be mailed to:

info@leetech.com

•  All product and sales needs can be mailed to:

sales@leetech.com
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